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Typography Infro

Typography Vocabulary

Typography is the thoughtful choice, arrangement and placement characters or glyphs in a layout. Choosing a typeface says
a lot about the designer, or the message of the piece you are creating. Good designers select typefaces that convey infenf and
purpose, Not typefaces that they simply think are " fun.”

Anatomy of Type

The fancy nofches on a character a called serifs:

—» Serif

If you want to help yourself, — * Ascender

Leading 1.y helping someone else first.

»Descender

X-Height Hello my name is Kelly McCathran.

The red line under the type is called the baseline. Type used to be set with lead, in the fradifional days they would have 12 point
type with a 2 point thick piece of lead in between each line. The term leading grew from that. Today we refer fo fype as 12 point
fype with 14 poinfs of leading (the height of the type counts in the leading value.)

Point Size Note

Serif EXGmpleS All of the fonts in the serif,

. . . sans-serif and script examples are
Times New Roman | Times | Garamond | Book Antiqua | Bookman Old Style 16 point, The size ook different

for almost every font because type

Sans-Serif EXGmpleS is measured from the top of the
) tallest ascender to the bottom of
Arial | Helvetica | Verdana | Century Gothic | Trebuchet MS the lowest descender. See how

large Zapfino looks in comparison
to all other fonts on the page.

Script
Braust SW | COI’\'\IC Sans | Tliisstter %W/ | “Eedwardian Qﬁlyj/ \ Dibloon | %&%

Note: Comic Sans falls into the category of sans-serif and casual script.
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Kerning

Kerning is the space between a pair of characters. Poor kerning con make type more difficult o read (more work for the brain.) Our
brain doesn't read letfters, or words it — reads senfence patterns

" n]' " " ]’ Tip
a’ a’S In Adobe programs to kern or

i Kernin
Kerning (space tightened Wt b Dore eadable) track use these shortcuts:

(the space between two letters)

Opfion oralt P (right arrow key)

TrGCkI ng option or alt 4 (left arrow key)

Tracking is the space beftween selected fext, meaning 2 or more characters. Tracking is offen used fo spread ouf headlines or call
emphasis fo individual words.

THESE WORDS ARE TRACKEPD

Font or Typeface

Today the term Font refers to the electronic file that is loaded on your computer and Typeface is the name or “brand” of the font
Init's simplest form, type can be divided into three primary cafegories (with many other, more specific sub-categories.)

AcCaslonPro-Regular.otf
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Character or Glyph

Init's purest form individual letters are called “characters.” If those characters are meaningful symbols, they are referred to as “glyphs.”

Technically characters are units of text storage and processing. Tasks such as searching and sorfing use characters. Glyphs
are visual shapes representing marks, signs or symbols. Some documentation will differ with this opinion. | fend fo lean foward
documentation from Adobe and Apple, since they are leaders in the design and creative field. Adobe invented PostScript and
the first fonfs.

Mayan Glyph for Cocoa (Kakau)

ka ka

AN -

AN

u

Character sets according fo Adobe (http.//oartners.odobe com/public/developer/opentype/index char setshitml):

“A character set is the collection of all characters in a given font or in a defined standard that specifies a set of characters for a given purpose. Character sets for
font products are usually determined by the operating system and the language for which they are intended.”

Character sefs according to Microsoft (htto://www.microsoft com/typography/unicode/cscp.him):

“We often speak inaccurately of character sets: we may refer to a “Greek character set” or a “Latin character set”. But in order to understand how different
writing systems are supported by Windows, we need to be more precise about characters.”

“Users don’t view or print characters: a user views or prints glyphs. A glyph is a representation of a chavacter. The character “Capital Letter A” is represented

by the glyph “A” in Times New Roman Bold, and “A” in Arial Bold. A font is a collection of glyphs. Windows is able to retrieve the appropriate glyphs by using

mapping information about the keyboard, the language system in use, and the glyphs associated with each character.”

Typography
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Tech Note

A character set 1s a collection
of characters and glyphs, they
include: WGL4, Mac Roman
and Unicode (used by modern
operating systems.)

Now I'm going to talk nerdy to
you: when examining a font file on
your computer, glyphs are typically
given names in the ‘post’ table
called “postnames” a character
mapping or “cmap” gives the
default information used to link
the glyph to the post name. Fonts
can have multiple cmaps in their
‘cmap’ table, allowing the font

to be used with more than one
character set.
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Hyphen, Em Dash or En Dash

| get asked these questions often when feaching InDesign: “When and where do I use a hyphen, em dash and do you ever use an en dash?” The
answers are in the following pages

Hyphen Em Dash

En Dash
Hyphens

| offen write hy-phen with the dash 1o illusfrate the character ifself. Hyphens should be used in compound words,
social security numbers ond phone numbers (maybe not for the entire number, that will date you.) The more modern frend for phone
numbers is fo use dofs (or periods.) SOme people prefer opening phone numbers with parenthesis (and by some people, I mean me.)

Hyphen Example:
e-mail or bi-level

Phone Number Example
onlineinstruct.com (888) 580-6635

More Modern Trend for Phone Numbers
onlineinstruct.com | 888.580.6635

*Old Fashioned Way” to Write Phone Numbers
Onlinelnsfruct.com « 1-888-580-6635

Note: I upper cased the onlineinstruct.com, because many people do that when writing emails to me. Our company name is branded all lower case, with the .com
in the name. It’s become a bit problematic to have to correct some business associates over and over again on this, but it is important for brand identity.
There is more on case later in this handout. I even used the bullet to illustrate that they used to be more common as separators. They have died out in the
age of twitter and facebook, since there is no visible “bullet key” (*) on most keyboards people are tending to use the vertical bar.

Typogrophy ©2013—kelly mecathran
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Tip

Do you know the other names for
the “vertical bar” character?

verti-bar | vbar | stick | poley
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En Dash -

En dosh is named for roughly the width of the leffer "N”. En dashes are used instead of hyphens for periods of fime (where you could
also use the word “to”) ONd for combining open cormnpounds,

En Dash Example:
Adobe has been in business from 1984-Present

Software-Application Conference or Oregon-California bborder

Em Dash —

Em dash, fo put it simply, was given it's name because of the widfn of the leffer "M" (although there is more technical detail to this, involving
ascenders & descenders that [ won’t get into here.) The leffer M is the widest character in our alphabet and on em dash fokes up roughly
that width. Longer than a hyphen, longer than an en dash. The em dash is the widest dash you can use. Em dashes con replace
commas, colons, semicolons ond parenthesis to add emphasis or cue to the reader a pause or abrupt change of thought. In
some cases em dashes should be avoided fo make the document more formal. Semicolons ond colons can indicate formality.
In the case of parenthesis and commas they can be use inferchangeably, where you might also choose an em dash.

Em Dash Example:

If you can't lead by example — af least be a horrible warning.

Space Before & After the Em Dash

Many people opt fo add a space before and after the em dash, for visual appeal. The standard practice is to have no spaces
surrounding the em dash, but sfandards often change. My preference is for the space before and affer (but that’s just me.)

Typography ©2013—kelly mecathran Page 5
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Ellipsis vs. Three Periods

Technically, an ellipsis (...) is three evenly spaced periods. The ellipsis is used when you'd like to eliminate words in a quote, or
entire sentences (the name is derived from the ancient Greek for “omission”) Another commaon use indicates fo the reader that the
fhought could confinue.

Many devices don't nave an ellipsis character (or the user can’t find the real character in symbols) in That case three periods are offen

substituted. People offen ask why should | use the real ellipsis character insfead of three periods. That character is known as

a triple-dot glyph. You can see in the example below that the real ellipsis character automatically confains spacing for the three

periods, making it more balanced and stronger.

An ellipsis can also be used in place of an em dash. -
1p

Note: Ellipsis do make your writing more casual. Psychologically using an ellipsis can evoke the feeling of longing or sadness. For some, it can be considered coy

or flirtatious. That little: dot, dot, dot Ellipsis keyboard shortcut ...

Examples: Mac: Option ;
Windows: Alt 133

three periods: v different fonts: e e e 000

the real ellipsis glyph: v differentfonfs: o e e 000
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Typography Resources

n Books

The Non-Designer’s Design Book
Your Mac is not a Typewriter & Your PC is not a Typewriter

Robin Williams
http://www.ratz.com

= E

ERLT

HO IR

Thinking with Type: A Critical Guide for Designers, Writers, Editors, & Students
Ellen Lupton

Stop Stealing Sheep & Find Out How Type Works
Eric Spiekermann and E.M. Ginger

TVpngO Dh\/ ©2013—kelly mecathran
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Typography Websites

Adobe Type Reference

htto://www.adobe.com/type/topics

Adobe Type Glossary

http://www.adobe.com/type/topics/glossary.ntml

My Fonts.com
htto://www.myfonts.com

WhatTheFont

htto://www.myfonts.com/WhatTheFont

WhaitTheFont App

htto://www.myfonts.com/WhatTheFont/mobile,

CreativePro.com > Fonts
htto://www.creativepro.com/fopic/fonts

Typography on Twitter

Typographica
http://twitter.com/typographica

Friends of Type

http://twitter.com/friendsoftype

Adobe | TypeKit (web loaded fonts)
htto://twitter.com/typekit

Typography Shop
htto://twitter.com/typographyshop

Typography
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Fonf Embedding & PDF

PDF Font Embed Status

The advantoge of a PDF (Portable Document Format) is that you can embed the fonts that you use in your layouts, so you don't have
fo use Arial or Times, or be dependent on the fonts the end user has loaded on their machine. Once a PDF has bbeen creatfed,

it is important fo check that the fonfs made if info the document, fully. To do this, open the PDF and choose File > Properties
(Command D or Gtrl D) then click the Fonts section at the fop. Ideally it should say (Embedded Subset) or for high-end print
(Embedded) next to every fonf in the list. In many cases, because of licensing restrictions, Truelype fonts may not fully embed
(more often on a Windows machine than a Macintosh™). If you don't see eifher. The fonf didn't make it in. The Stfandard setfings from Adobe

don't embed ANY Microsoft Fonts

Font Embed Status

Document Properties

Document Properties

{Description | Security | Fonts Initial View | Custom

Advanced {Description | Security | Fonts  Initial View | Custom | Advanced

Fonts Used in this Document

Fonts Used in this Document

v (& AGaramond-Regular (Embedded)
Type: Type 1
Encoding: Custom
¥ (@ BernhardMedern-Roman (Embedded)
Type: Type 1
Encoding: Ansi
v a Futura (Embedded)
Type: Type 1
Encoding: Roman
varumra-md (Embedded)
Type: Type 1
Encoding: Custom
v (& tcEras-Ultra (Embedded)
Type: Type 1
Encoding: Roman
v (& ZapfDingbats
Type: Type 1
Encoding: Custom
Actual Font: ZapfDingbats
Actual Font Type: Type 1

( Help )

Typography

v a BernhardModernStd-Italic (Embedded Subset)

Type: Type 1
Encoding: Custam

v (@ Ber R Subset)
Type: Type 1
Encoding: Custom

v@ d-R Subset)

Type: Type 1 (CID}
Encoding: Identity-H

v (& Brushscriprstd (Embedded Subset)
Type: Type 1
Encoding: Ansi

v @ MyriadPro-BlackCond (Embedded Subset)
Type: Type 1
Encoding: Ansi

v @ MyriadPra-BoldCond (Embedded Subset)
Type: Type 1
Encoding: Ansi

v (& MyriadPro-Light (Embedded Subset)
Type: Type 1
Encoding: Custom

Cancel ) (SO Help Cancel

(ST ]
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Fonf Embedding & PDF

Acrobat & Adobe Reader Font Substitution

In some cases, fonts may not be able fo be embedded because of licensing restrictions. In this case, the person receiving the PDF
will need fo have the fonf installed on their machine for if fo display properly. The fext below can only be viewed on a PC with the
Truelype Font loaded. The Mac and Unix users are out of luck, it is simply not available. Here is the example:

American Dream PDF on a Machine with the Font Loaded

Same PDF file on a Macintosh™

New Text

When a fontis not fully embedded or subsetf, Acrobbat or Adobe Reader will substifute Adobe Sans MM or Adobe Serif MM. They
are loaded from a resource folder inside Acrobat and will not show up as a selection in any ofher application.

Loading PDF Settings

You can use the PDF seftings on our class fles page under PDF Settings (joboptions):

http://onlineinstruct.com/class files.html

Download the file, de-compress the zip and double click the joboptions file fo load (it will launch Distiller and put the file in the proper
place). Once you de-compress the zip file (from above), | recommend using the Proof_UnFlattened.joboptions as a good laser
printer or email proof quality default PDF seftings file. You might have fo click Save As, then OK if you are on a PC (don’t change the
location where it is saving).
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Reference

Symbol & Keyboard Reference

The Windows Alf codes are below the Mac shorfcufs. In most Adobe applications you can see all the characters that exist for a
font under Type > Glyphs or Window > Type & Tables > Glyphs. Once the panel is open, you can double-click on the symiool 1o

insert it where your cursor is.

L] &8

i
1
i

l— ® an|ofan O > [
—— oY o > O | Of PR | L
= =0 e O e Oy

— =m0y X

—_— = 0 e T = | 2
M| = O O | O

A =M C - T —

MR ST ow | S D S e
b =D | () S = =< =

oo mo o | m

o e

{l—,::"rnn a M CI'I'IR‘F‘
— | x| || o — R
§..__, o> oo | O > |

| === D e Y e

Opening DOUDIE QUOTE 1. e e e e
CIOSING DOUOIE QUOME
OPENING SINGIE QUOME
CIOSING SINGIE QUOTE
P D0 —

E OIS =

Typography

i Opfion [
. Al 14%
v Opfion Shiff [
... Al 148
i Opfion ]
G Al 148
v Option Shiff ]
.. Al 146
i Option Shiff -
... Al 181
i Option -
s, AlE 180
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Foreign Accents & Punctuation

Acute vowel GEIOUAEIOU ... OpOTION €, VOWE
... Alt 160
... Alt 130
... Alt 161
... Alt 162
... Alt 163
.. Alt 253

<co 0o

Urmlaut vowel esgiouy AEIOUY .. Opfion u, vowel
... Alt 133
... Alt 137
... Alt 139
......Alt 148
... Alt 129

... Alt 153

‘<: - O 4 - Q

... Alt 143
... Alt 160
... Alt 160
... Alt 183
.. Alt 154

O T

OU . Opfion ~, vowel
... Alt 224
... Alt 2323
... Alt 236
... Alt 242

. Alt 249

GCrave vowel agiot AE

s O :4’ [0 Q/

... Alt 192
... Alt 200
... Alt 204
... Alt 210
.. Alt 154

O T >

Typography ©2013—kelly mecathran Page 12



Circumflex vowel a&ia0 AE

[« IR}

OO T I>

Left Guillernets « (angle quotes or french QUOTATIONS) ...l
RIght Guillemets » (angle quotes or fremch quotations) ...
LEff SINGIE GUIIME!S ¢ o
RIGHT SINGIe GUIMENS > .
BSEING DOUDIE QUOTE . o
BOSIN SINGIE QUOIE .
QUESHON MK DOWN ,
EXCIGMGHON MG DOWN | o
COGHIEG o
COPHOISIGSNET D
S SIOSNEA @
DEUISONET DOUDIE S B
. AL 223 or Al 228 or Ctrl Alt S
DIOMESS T(I) . e e e e

Typography

i Option i, vowel
... Alt 226

... Alt 234

... Alt 238

... Alt 244

... Alt 251

... Alt 194
... Alt 203
... Alt 206
... Alt 213

... Alt 219

i Option \
. Al 174
v Option SHIfT \
.. Al 178
v Option Shift 3
. AlE 139
e Opfion Shift 4
C.. AlE 188
e Option SOIft W
civvii. Option SNIfT O
oo Opfion Shift ?
... Alt 168
i Option
.. Al 173
i, Option ©
. AlE 138
e Option Shift O
.. Alt 216
i Opfion ©
... Alt 248
i Option s

e Option Shift o
... Alt 305

©2013—kelly mccathran
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SN T T
T N oo,
T DY
O O
B e T
RIN G A N T oo e e e e e
RN G A o o e e e e e e e
DO A N,
. Al 249 or Alt 250
POUNG STEIING © e e e

O

Typography
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... Opfion Shift N

.. AlE7323

... Option N, Shiff N
... Alt 165 or 209
e Option nn

f.. Al 164

......... Opfion Shift
oo Option Shiff .

i Option k
.. Alt 248

oo, Option Shift A

. Al 148
i Option h

i Option 3
... Alt 186
i, Opfion y
.. Alt 187

Reference
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Math Symbols

DIV ISl o
PILS OF VINUS
GrOQIEr TGN OF EGUI 2
LE8 1O OF EGUTI S
ADDIONIMIONE €GO o

NOT UG 7 e e e e e e

POIHGIDIFIBIBNMIG 3 o
IOHEGITH
FIOTIN e
QPG OMEGT ()
QPG DBIG B o
PIOGIUGHTT
SURIIIONON T -
BT

ROITIC Ol Y oo e e e e e e

Typography

i Option /
. Alt 246
oo Opfion Shift =
... Alt 241
Opfion .
... Alt 242
Option,
... Alt 243
Option x
... Alt 247
Option =
Option 5
... Alt 236
Optiond
... Alt 229
Opfion b
... Alt 244
Opfion f
... Alt 159
Option z
... Alt 234
e Opfion
e NO alf code
viivvire.. Opfion Shift P
. Al 327
oo Opfion W
c.... Alt 328
i Option P
c... Alt 237
i Opfion v
... Alt @81

©2013—kelly mccathran
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Symbols

DIEOIEE © i
FIOCTION BAT OF SIGSN/ 1. e e
VEITICOI BOT | o e e e e
CApAl LIGOTUIE A e e
SMAITLIGOTUIE G- 1. e e e e e,
LIGOTUIE Tl o e e e e e e
GO U Tl e e e e e

ST ION § e

BUI T =
COPYNGNT O 1 e

REGISHEIET TIAGBMGIK B ..o
DOGGET T e
COMESIGN © e
Fractions
ONE HOI V2 e e
OE QUOIET Yh e

TNrEE QU OIS

Typography
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Option Shift 8
... Al 176
... Opfion;
... Alt 133

Opfion Shiff 1

.. No alt code
v SHIFE
... Shift\
Opfion Shiff*
e AT98
... Opfion”
Opfion Shift &
Opfion Shift 6
i, Option 6
... Alt 167
Opftion 8
Option g
... Alt 169
Opfionr
... Alt 174
Opftion 2
... Alt 183
Opfion t
... Alt 134
Option 4
e AP T62

no mac shortcut
... Al 171
no mac shortcut
... Al 172
no mac shortcut
... Al 190

Reference
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Webdings Characters

These symbols may vary between Mac & Windows with older Truelype & PostScript Fonts.

®®®wm@wacmr.f+*ﬁ@ElmacD&x
N xS < C 42 ~00D053 _~ . 5Q .0 00O0TQ
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AIALATDIET T 00 = GATAMI 2 a v 2 %

— N O < W0 O S 00O
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@ >

» o ® _

« Qo

NOV IR R 1@REX

+

N

P m
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Zapf Dingbats Characters

These symbols may vary between Mac & Windows with older Truelype & PostScript Fonts. In the list below, we are using the font
/apf Dingbats in the style Regular (not ITC Zapf Dingbats.)

SNAAOW BAlOT BOX UD I 1o e o e e e
SNAAOW BAlOt BOX DO [ o
BD BAlOT BOX UD DA oo e e e
B Bl O BOX DO T
Flled BalOr BOX I . oo
Opening Grear QUOTE 8 .. e e
CloSING CreOt QUUOTE 98 ... e e e e e e
Opening SINGIe Graar QUUOTE 8 ... e e
ClosiNg SINGle GreOt QUOTE 8 ... e e,
IO BUI T @ o
Great SNAAOW BUIET O o
Flled ATOWNEOO B o
RIGNT AITOW 3 1o e e e e
FOT RIGNT AITOW B o e e e e
D RIGNTAITOW B 1 e,
SPEEAING RIGNT ATTOW M .1 e,
THONGIE UD A o e e e e e
THIONGIE DOWIN W e e e e e

OV L @ oo
K T
N K TN I K 0
JOCCUSE BB oo
VICTOTY 8 o
SCISSOIS B ..o e e e
PENCIE SITQIGNT @ 1 e e e
PEN NI C8 L
TEIEPDNONE B oo
IO M
S I R
U O IO S O o
OCTASTON H oo e
BIG ASTEIISK S ..o e
GO T U B
S O K B oo

Typography

O

©

g
N
Shift ]
Shift
Shift [
Shift\
\
oo Option Shiftr
i Option ]
oo Option Shifty
v Option Shift
v Option Shift 7
S
i Option /7
8
e Shft =
i Comma
i SHIfT 4
/
e SNIFTS
coe ST
e SNITTH
i SHIEF
e SPIFTW
i SNt Z
o]
d
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